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はじめに 
 

MPC Beatsについて 
 

Akai Professionalの最新フリー・ソフトウェア MPC Beatsは、専用のハードウェアを必要とせずに、MPCソフトウェア 2ゆ

ずりのワークフローで楽曲制作が可能です。MPC Beatsは以下の基本的な機能を備えています。 

• 最大 8x MIDI トラック 

• 最大 2x ステレオ・オーディオトラック 

• 4x エフェクト・スロット、8x サブミックス・チャンネル 

• 内蔵 AIR FX エフェクト 

• 内蔵プラグイン音源・AIR Bassline、 Electric、TubeSynth 

 

MIDI トラック(最大 128)とオーディオトラック、追加プラグインなど、より制限のない MPC体験を得るためには、ソフトウェ

アのメニューアイコンをクリックし、ヘルプからフル機能 MPC ソフトウェアへのアップグレードをお勧めします。詳細は

akaipro.comにてご確認ください。 

 

このガイドでは、MPC Beatsでの音楽制作をご案内します。MPC Beatsのインストールと設定の詳細については、「基本セ

ットアップ」のセクションを参照してください。最初のプロジェクトを始める際のチュートリアルについては「操作について」

のセクションをご覧ください。MPC Beatsのすべての機能について詳しく知りたい場合は、ソフトウェアのメニューアイコン

をクリックし、Help > MPC Beats Helpを選択し、MPC Beats Software Manualをクリックして MPCソフトウェアのユーザ

ーガイドを開いてください。※ユーザーガイドはMPCソフトウェア全体をカバーしているため、記載されている機能や機能

の中には MPC Beatsと互換性がないものもあります。 

 

システム条件 & プロダクト・サポートについて 
 

本製品の最新情報（システム要件、互換性情報など）や製品登録については、akaipro.comをご覧ください。 

 

基本セットアップ 
 

導入手順 
 

1. akaipro.com にアクセスし、Products>MPC SERIES>MPC SOFTWAREへと進みます。 

2. DOWNLOADをクリックし、必要な情報を入力した後で GET DOWNLOAD LINKを押します。登録したメールアドレス

宛にメールが届きますので MPC Beatsやサウンドコンテンツをダウンロードします。 

3. ダウンロードフォルダを開き、MPC Beatsインストーラーをダブルクリックしてインストールを進め完了させます。 

4. サウンドコンテンツも MPC Beats同様に画面の指示に従いインストールを完了させます。 

Note: デフォルトでは、MPC Beats ソフトウェアは WINDOWS の場合  \Program Files\Akai Pro\MPC Beats 

(Windows®)、もしくは mac の場合は、Applications (macOS®)にインストールされます。インストールの際にデスク

トップにショートカットを作成するように設定もできます。 

クイックスタートガイド 
Manual Version 1.3 
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MPC Beatsを始めてみましょう 
 

1. パソコンで、MPC Beatsソフトを開きます。 

2. 初めてソフトウェアを開くと、スタートアップウィザードが起動し、3

つの簡単なステップでセットアップを行うことができます。 

i. まず、USB ケーブルを使用して MIDI デバイスをコンピュータ

ーに接続します。 

ii. 次に、お使いのコントローラーの MIDI マップを選択します。

Akai Professional、M-Audio、Alesisなど、サポートされている

デバイスをお持ちの場合、MPC Beatsは自動的にMIDIマップ

を選択します。その他にも、一般的なMIDIコントローラー用の

マップが用意されています。 

メモ：MPC Beatsをプラグインとして使用する場合、MIDIマッ

ピングは手動で設定する必要があります。 

iii. 最後に、シンプルなワークスペースかアドバンスドなワークス

ペースかを選択します。この選択で、主要ワークフローの表示

を変更することができます。この設定は、メニューアイコンか

ら 、 [View] > [Workspace] を 選 択 し 、 [Simple] ま た は

[Advanced]をクリックすることで、いつでも変更することがで

きます。 

終了したら、Start Making Beats をクリックしてセットアップウィザ

ードを終了します。スタートアップウィザードは、メニューアイコン

をクリックして Helpを選択し、Open Startup Wizardをクリックす

ることでいつでもアクセスできます。 

3. 次の画面では、プロジェクト・テンプレートまたはデモプロジェクト

を選択して、プロジェクトを開始することができます。空のテンプ

レートを開くには、Empty Project をクリックします。または、最近

使用したプロジェクトをロードすることもできます。 

4. MPC Beatsソフトウェアで、環境設定/Preferenceを開きます。 

Windows：メニューアイコンをクリックして、EDIT を選択し、

Preferenceを選択します。 

macOS：MPC Beatsメニューをクリックし、Preferencesをクリ

ックします。 

5. Preferenceウィンドウで、Audioタブをクリックし、使用するサウン

ドカードを選択します。完了したら、[OK]をクリックします。 

重要：可能な限り外部オーディオインターフェースの使用をお勧め

します。 

Windows のみ：内蔵サウンドカードを使用する必要がある場合

は、発音遅延改善のため、最新の ASIO4ALL ドライバーを

asio4all.comから入手し、インストールすることをお勧めします。 

次の『MPC Beats におけるオーディオの設定』項目も参照してく

ださい。 
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MPC Beatsにおけるオーディオの設定 
 

この項目では MPC Beatsの音声の入出力設定に関してご説明いたします。Win/Mac、オーディオインターフェースをお持

ちの場合等、様々なケースがあるかと思いますので、下記ご参照いただけますでしょうか。 

 
 

●Windows/オーディオインターフェース未接続/Asioドライバーを導入していない場合 
 

オーディオインターフェースをお持ちでない場合、また、Asioドライバーを導入されていない場合。 

Windows標準のドライバーを Audio Device Typeで選択し、Outputには PCのスピーカーを選択します。Inputはオーディ

オインターフェース等を接続していませんので空欄になります。 

 

 
 
 

Windows標準のドライバーでは発音遅延が起こりますので、オーディオインターフェースをお持ちでない場合は Asio4all

の導入をお勧めいたします。 

 

※ASIOドライバーはオーディオインターフェースなどのハードウェアメーカーがそれぞれのハードウェアに対応したものを

配布していますが、ASIO非対応デバイスを ASIO化するためのフリーのドライバー「ASIO4ALL 」というものも存在しま

す。  

 

※弊社ソフトウェアではございませんので使用方法や詳細に関しましてはサポート対象外となります。 

 
 
 
 
 
 

https://www.asio4all.org/
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●Windows/オーディオインターフェース未接続/Asioドライバーを導入した場合 
 

オーディオインターフェースをお持ちでない場合で、発音遅延を改善したい場合は、 

※asio4all( https://www.asio4all.org/ )を導入します。Audio Device Typeで Asioを選択し、Deviceでは asio4allを選択し

ます。これにより発音遅延も改善されます。 

音声は PC本体内蔵のスピーカーか、接続したヘッドフォン/スピーカーから出力されることになります。 

 

 
 

※ASIO「Audio Stream Input Output」はドイツの Steinberg社が策定したドライバー規格です。 

Windows搭載 PCで ASIO対応ソフトウェアや機器を使用する際に機能的・音質的に最高のパフォーマンスを得られるド

ライバーで、Windowsでの音楽制作用のサウンドドライバーとして広く普及しています。  

 

Windowsには標準で搭載されている DirectSound、MME、WDM、WASAPI、USB Audio 2.0、DirectXなどのサウンドドラ

イバーがあり、通常の音楽・動画再生だけであれば全く問題ありませんが、シビアな音楽制作の場ではこれらWinodws標

準ドライバーのままでオーディオインターフェースや MIDIキーボードを使用すると遅延（レイテンシー）が発生し演奏や録

音に大きな影響を及ぼします。  

 

また、ソフトウェア内部のバッファサイズ設定を調整することで遅延（レイテンシー）を改善できることもありますが、PCの

スペックによっては処理仕切れずに音切れやノイズが発生する場合があります。 

 

こういった問題を解決する為に ASIOドライバーの導入が必要となります。ハードウェア(オーディオインターフェース)には

それぞれに対応したドライバー(ASIOを含んだ)が配布されていますので、必ずダウンロードしてインストールを済ませてお

きましょう。また、ソフトウェア側の設定で使用する製品の専用ドライバー/ASIOを必ず選択しておきましょう。 

 
 
 
 

https://www.asio4all.org/
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●Windows/オーディオインターフェースを接続している場合 
 

オーディオ・インターフェイスとは： マイクからの音声や楽器音を PCに録音する為の機器。オーディオインターフェースを

介して高音質で音声を録音、または再生したりと、多様なサウンドを取り込む為に楽曲制作には欠かせない機器です。 

 

オーディオインターフェースを接続されている場合は、オーディオインターフェース専用ドライバーを事前に導入していただ

き、Deviceで選択できるようにします。下図では一例として M-audio AIR192/4を接続し専用ドライバーも導入している状

態になります。この場合、音の入力出力共に AIR192/4を介して行われることになり、発音遅延も改善されます。 

 

 
 
 

■オーディオインターフェース(一例) 
 
M-AUDIO 192/4   http://m-audio.jp/air192_4/ 
M-AUDIO 192/6   http://m-audio.jp/air192_6/ 
M-AUDIO 192/8   http://m-audio.jp/air192_8/ 
M-AUDIO 192/14 http://m-audio.jp/air192_14/ 
 
 
 
 
 
 
 
 
 
 

http://m-audio.jp/air192_4/
http://m-audio.jp/air192_6/
http://m-audio.jp/air192_8/
http://m-audio.jp/air192_14/
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●Mac/オーディオインターフェースを接続していない場合 

 

Output/Inputの各設定は macデフォルトの選択になります。この場合、音声の出力はスピーカーから、入力は本体内蔵の

マイクからという事になります。 

 

 
 

●Mac/オーディオインターフェースを接続している場合 
 
Output/Inputの各設定は接続したオーディオインターフェースを選択する事になります。下図はその一例として M-AUDIO

の AIR 192/4を接続している場合になります。 
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操作について 
 

MIDI コントロール・マップ 
 

MPC Beatsには、人気の MIDI コントローラーの多くのコントロールマップがプリロードされていますので、スタートアップ

ウィザード、または MIDI LEARN 機能から、サポートされている MIDI コントローラーリストを閲覧・選択することができま

す。これにより、MPC Beats のインターフェースを簡単にコントロールし、キーやパッドを使った楽曲制作をすることができ

ます。 

 

※MPC Beats のドラムプログラムに合わせてコントローラー側のプリセット(AKAI 独自のノート配列に)を切り替えていた

だく必要がございます。また、ソフトウェア側とコントローラー側でのパッドにずれがある場合はMIDI LEARN 機能で編集

することも可能です。  

 

MIDI LEARN 機能で編集する場合 – ソフトウェア右上のLEARN ボタンを押した後、黄色で示されているソフトウェア側の

パッドをクリックします。次にコントローラー側のパッドをタップすることでソフトウェア側のパッドとコントローラー側のパ

ッドをマッピングすることができます。 

 

例えば、Akai Professional MPK mini MK2は、多くの MIDIコ

ントローラーと共通の構成である 8つのパッドと 8つのノブを

搭載していますので、キー、ノブ、パッドが自動的に MPC 

Beats のキーボード、Q-Link、パッドにそれぞれマッピングさ

れます。 

右の画像は、MPC BeatsのメインモードでのQリンクとパッド

です。MPK miniの 8つのパッドはパッド A01～A08を、8つの

ノブはQリンク 1～8をコントロールします。MIDI コントローラ

ーに複数のパッドやノブバンクがある場合、これらの機能を利

用して、ソフトウェアで追加のパッドや Q リンクにアクセスす

ることができます。  

MIDI コントローラーの鍵盤は、選択されたトラックのタイプに

応じて、パッドやピアノロールの音符をトリガーするためにも

使用できます。 
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MIDIキーボード(MPK MINIシリーズの場合)が反応しない場合  
 

下図を参照していただき、環境設定/Preferenceから MIDI /Sync設定をご確認ください。 
 

 

 

 

 

シンプル/アドバンスド・ワークスペースの選択 
 

スタートアップウィザードでは、シンプルなワークスペースとアドバンスドなワークスペースを選択することができます。こ

れにより、MPC Beatsのツールバーに表示される機能が変更され、ワークフローをより効果的に調整することができます。 

 

シンプル・バージョン 
 
 

 

 

 

 
 

アドバンスド・バージョン 
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メインウインドウ 
 

ツールバーの下には MPC Beatsのメインウィンドウがあります。下の画像は、ツールバーの左上のハウスアイコンを押すこ

とでアクセスできる MPC Beatsのメインモードの主な機能の概要を示しています。 

 

 

 

 

 

 

  

インスペクターを使用

して、シーケンス、トラ

ック、プログラムの変

更を素早く行うことが

できます。 

チャンネルストリップ

を使用して、プログラ

ム、パッド、トラック、

マスターチャンネルの

ボリューム、パンニン

グ、ルーティング、イン

サートを変更すること

ができます。下のアイ

コンを使用して、表示

するチャンネルストリ

ップを選択します。シ

ンプルビューでは表示

されません。 
Q-Link を使用して、さまざま

なパラメータを制御すること

ができます。Q-Link モードを

使用して、制御するパラメー

タを選択します。 

パッドセクションを使用してノート

をトリガーしたり、ステップシーケ

ンサーでステップを挿入したり、サ

ンプルエディットモードでサンプル

を操作したりすることができます。 

プロジェクトウィンドウには、プロ

ジェクトに含まれるサンプル、プロ

グラム、シーケンスなど、プロジェ

クトの概要が表示されます。 

ブラウザを使用して、

拡張機能、サンプル、

プロジェクトなどをロ

ードします。また、この

エリアを使用して、ウィ

ンドウの下部にあるア

イコンをクリックして、

プロジェクト情報、プロ

ジェクトノート、元に戻

す履歴を表示すること

もできます。 

クイックヘルプウィン

ドウでは、MPC Beats

ソフトウェアの一部に

カーソルを合わせる

と、ツールチップが表

示されます。これは、

下のクエスチョンマー

ク(?)アイコンをクリッ

クすることで有効ま

たは無効にすること

ができます。 

イベントの挿入や編集にはグリッドを使用します。プログラム

の種類に応じて、左側にパッドやピアノロールが表示されま

す。このエリアは、波形表示やリスト表示にも使用されます。  
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チュートリアル 
 

MPC Beatsのグラフィカルインターフェースに慣れてきたところで、次のページでは、(Empty)空のプロジェクトから新しい

曲を作成する方法を説明し、MPC Beatsソフトウェアの重要な機能を紹介します。さあ、始めてみましょう！ 

 

トラックとシーケンスの作成 
 

MPC Beatsでは、最大 8つのMIDIトラックと 2つのステレオ・オーディオトラックを作成することができます。まずは、いく

つかのトラックを作成し、シーケンスを録音してみましょう。 

 

ドラムトラックの作成 
 

簡単なドラムキットを作ってみましょう。ブラウザ（右の画像を参照）を使って、お気に

入りのドラムサンプルを探すか、Akai Professional のプリロードされたコンテンツから

始めてみましょう。ブラウザでサンプルをダブルクリックしてロードするか、サンプル

をソフトウェアのパッド上にドラッグしてロードすることもできます。まずは基本とな

るキックドラム、スネアドラム、ハイハットをロードすることから始めましょう。 

 

ドラムキットがセットアップされたので、ドラムシーケンスを録音してみましょう。 

1. MPC Beats のソフトでは、左上のハウスアイコンをクリックして、メインモードにな

っていることを確認します。 

2. Tempo フィールドを使用して、シーケンス全体のテンポを設定します。 

3. 録音モードを有効にするには、Rec ()ボタンを押して待機状態にします。 

4. 次に Play ()ボタンを押して、録音を開始します。プリカウントは、録音を開始す

る 1 小節前からカウントします。特にパッドでドラムを演奏することに慣れていな

い場合は、順番に 1つずつサウンド（パッド）を録音することをお勧めします。   

5. MIDIコントローラーのパッドまたは鍵盤を使って、簡単なキック/バスドラムのパタ

ーンを演奏します。録音したノート(音符)は自動的にグリッドに配置されます。デフ

ォルトの小節の長さは 2 小節、16分音符です。 

2 小節を過ぎると、録音は自動的にオーバーダブモードになり、シーケンスは頭か

らループ再生し続けますので、さらに重ねて録音することができます。 

6. スネアドラムのパートを演奏して、次にハイハットのパートを演奏します。 

7. 録音が終わったら、Stop ()を押します。ソフトウェアのグリッドエディタには、録

音した内容が表示されます。 

一旦停止させてから通常録音をやり直すと、先ほど録音した内容が上書きされ新しい

ノート(音符)に置き換わってしまうことに注意してください。これを防ぐには、Rec ()

の代わりに Overdub ()を押します。オーバーダブ録音では、先ほど記録したシーケ

ンスに重ねて追加のノートイベントを録音することができます。 

Undo ボタンは、モードにより機能が異なります。通常、Undo ボタンを押すと、最後に

記録したイベントだけが取り消されます。元に戻すイベントがある場合は、Undoボタン

が点灯しています。 

録音中は、元に戻すボタンが点滅します。この場合、元に戻すボタンを押すと、その録

音からすべてのイベントが消去されます。（つまり録音開始の Play ()または Play 

Start (|)が押されてからのすべてのイベント） 
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トラックとプログラムの追加 
 

次に、ドラムシーケンスにベースを追加してみましょう。例えば、キーグループ・プログラム

/Keygroup programを使用すれば任意のサンプルで音階演奏が可能になります。または、付

属の AIR Basslineプラグインを使ったりと、様々な方法でベースフレーズを作成・追加するこ

とができます。 

いずれの場合も、新しいトラックとプログラムをプロジェクトに追加する必要があります。 

ベース用に新しいトラックを追加するには、インスペクターの Track フィールドをクリックし、表

示されたトラックリストの中から 例)Track 2 (unused)をクリックし、トラックの名前を変更しま

す。（例：ベースライン） 

次はベースラインを録音するためのプラグインプログラムをトラックに追加してみましょう。  
 

新しいプラグインプログラムを作成するには： 

1. 画面左端にあるインスペクターにある、プラグインプログラムを示す Track フィールドの

下のプラグアイコンをクリックします。（電源プラグ形状のアイコンです。他に Drumモード

/Keygroupモード/Clipモード・アイコンなどがあります。） 

新しいプラグインプログラムの名前が、下の Programフィールドに表示されます。 

2. 新しい Programの名前をダブルクリック、名前を変更して Enterキーを押します。 

3. Pluginメニューをクリックし、表示されたリスト内の MPC Plugins > Bassline を選択し、

Select で決定するとトラックに追加されます。 

4. Pluginメニュー下の Presetから音色を選択します。 

プリセットリストで気に入った音を見つけてベースラインを録音してみましょう。MIDI コントローラーを使用している場合

は、ドラムトラックに合わせてベースラインを演奏して録音してみてください。※録音した音はいつでも編集することがで

きます。 ここまでのご説明で 2小節のシンプルなドラムシーケンスとベースラインができたと思います。 
 

オーディオトラックの録音 ※要オーディオインターフェース 
 

最後に、すでに録音したドラム&ベースのシーケンスに加えて、オーディオを録音してみましょう。 

1. ツールバーのハウスアイコンをクリックして、メインモードに入ります。 

2. インスペクターの上部にある Audioタブをクリックします。Trackフィールドに Audio 001が表示されます。 

3. マイク、ギター、シンセサイザーなどのオーディオソースをオーディオインターフェースに接続します。 

4. オーディオトラックのチャンネルストリップ： 

i. オーディオインプット・メニュー(Input __)をクリックして、入力ソースとして Mono > Input 1 または Stereo > 

Input 1,2 を選択します。 

ii. アウトプット・メニュー(Out __)が Out 1,2に設定されていない場合は、それをクリックして Output > Out 1,2

を出力として選択します。 

iii. モニターボタンをクリックして、AUTO/IN/OFFの 3 つの状態を切り替えて、「Auto」（トラックが録音可能な場合

のみ、インプット・オーディオを聞くことができます）に設定します。 

5. オーディオソースを再生しながら、オーディオインターフェースの入力レベルを設定します。ソフトウェア上のレベルメ

ーターに反応がありますので、最大レベルを超えないように設定してください。 

6. オーディオトラックのチャンネルストリップで、パンノブの横、もしくはモニターボタン(AUTO/IN/OFF)の下にある

Record Arm ()ボタンをクリックして、トラックを録音可能にします。 

7. ツールバーの Rec ()または Overdub () をクリックして録音待機状態にします。 

8. 次にツールバーの Play ()または Play Start (|)ボタンをクリックして、オーディオトラックへの録音を開始します。先

ほど録音したドラムやベースがバックグラウンドで再生されているのが聞こえてくるはずです。 

録音を停止するには、ツールバーの Stop ()ボタンをクリックします。 
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エディット&ミキシング 
 

録音が完了したら、シーケンスに追加したノートイベントやオーディオを編集したい場合があります。 

 

エディット 
 

MIDI イベントは、メインモードのグリッドエディタで編集することができます。グリッドエディタには、ドラムとクリップ・プロ

グラム用、キーグループ、プラグイン、MIDI、CVプログラム用、オーディオトラック用の 3つの異なる外観があります。 

グリッドエディタに入るには、画面左上隅にあるモードアイコンの下の GRIDをクリックします。 

※GRID以外にWAVE/パッドアサインされた波形表示、LIST/リストエディット(データの数値入力・編集)もあります。 

 

インスペクターで MIDI タブを選択すると、グリッドエディタに

シーケンスの詳細：MIDI トラックのノートイベントとそのベロシ

ティなどが表示され、編集することができます。 

ドラムプログラムの場合、左の列には、使用可能なすべて

のパッドナンバーとサンプル名が縦に表示されます。  

キーグループ、プラグイン、MIDI、CV プログラムの場合、

左の列には縦長のピアノロール・キーボードが表示されま

す。 

ペンシル、マーキー、消しゴムツール(画面上部中央アイコン)

を使用して、ノートの挿入、選択、削除を行うことができます。 

  

インスペクターの Audio タブを選択すると、グリッドエディタ

画面がオーディオトラックのオーディオ波形に切り替わり、編

集することができます。 

マーキー、矢印、ペンシル、消しゴム、ハサミ、ミュートツール

を使ってオーディオ波形を編集します。 

また、アイコンの下にある追加ツールで、波形のレベル、チュー

ニング、BPM を編集したり、フェードイン・アウトを適用したり、

オーディオ波形をワープしたりすることもできます。 

 

MPC Beatsの Program Edit Mode/プログラムエディットモードには、プログラムを編集するためのすべてのパラメーター

が含まれています。また、サンプルが適切にチューニングされ、最適なレベルであることを確認したり、キーグループを編

集、エフェクトを適用、プラグインのプリセットを調整したりするためにも使用できます。 

プログラムエディットモードを開くには、ツールバーの 4 つのパッドアイコンをクリックします。ウィンドウの上半分には、グ

リッドエディタ、ウェーブエディタ、リストエディタが表示されます。ウィンドウの下半分には、Q-Link パネル、Pad パネル、

Program Editor パネル、Project パネルが表示されます。対応するセレクター(画面左下の小さなアイコン)をクリックすると、

それぞれの表示・非表示を切り替えることができます。 

まずドラムプログラムを選択し、プログラムエディッ

トモードを開き、各パッドのレベルを調整します。シ

ンバルやスネアなどのパンや音量調整（写真左の枠）

さらに、(写真右の枠)バスドラムのサウンドをチュー

ニング(SEMI/FINE)や、サウンドを重ねることもでき

ます。(SAMPLE LAYERS、各パッド最大４つまで) 

次に、プラグイントラックを選択し、プログラムエディ

ットモードを使用して、Bassline プラグインのパラメ

ーターを調整します。 ※プログラムエディットモード

はオーディオトラックには使用されません。 



  

 
13 

 

ミキシング 
 

メインモードのチャンネルストリップの他に、チャンネルミキサーやパッドミキサーなどのモードを使用して、パッドやプログ

ラム、トラックをミックスすることができます。  

 

チャンネルミキサーを開くには、ツールバーのスライダーアイ

コンをクリックします。 

チャンネルミキサーは、すべての MIDI トラック、オーディオト

ラック、プログラム、サブミックス、リターン、マスタートラック

のチャンネルストリップを表示し、現在選択しているシーケン

スのオーディオミキサーのように動作します。ここから、トラッ

ク、プログラム、リターン、サブミックス、マスターのレベル、ス

テレオパニング、ルーティング、エフェクト(INSERTS をクリッ

クしてエフェクトをアサインできます。)などの設定を行うこと

ができます。このウィンドウの上半分には、各シーケンスのト

ラックとプログラムの概要を示す Track View が表示されます。

これを使用して、現在のシーケンスの複数のトラックを一度に

編集することができます。 

シーケンスを選択してチャンネルストリップを表示します。MIDI 

プログラムや CV プログラムにはプログラムストリップは表示

されませんが、MIDI トラックにはチャンネルストリップが表示

されます。 

 

パッドミキサーを開くには、ツールバーのパッド＆スライダー

アイコン（表示されている場合）をクリックするか、ツールバー

の他のモードアイコンの横にある下向き矢印()をクリックし

て、Pad Mixerをクリックします。 

パッドミキサーは、オーディオミキサーのようにパッド毎に

様々な設定を行うことができます。ここでは、プログラムのレ

ベル、ステレオパンニング、ルーティング、エフェクトを設定す

ることができます。ウィンドウの上半分には、グリッドエディタ、

ウェーブエディタ、リストエディタが表示されます。 

トラックを選択すると、そのプログラムとパッドのチャンネル

ストリップが表示されます。MIDI トラックが選択されると、そ

のプログラムのパッドチャンネルストリップまたはキーグルー

プチャンネルストリップが左側にグループ化されます。右側に

は対応するプログラムのチャンネルストリップが表示されます。

オーディオトラックやプラグインプログラムを使用したトラック

が選択されている場合、パッドチャンネルストリップは表示さ

れません。MIDI プログラムや CV プログラムを使用しているト

ラックが選択されている場合、パッドチャンネルストリップや

プログラムストリップは表示されません。) 
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データ・セーブ&ソング・モード&エクスポート 
 

作業を進めていく中で、大事なデータをセーブ/保存したり、エクスポート/書き出したりする場面があると思います。 

プロジェクトを保存するには、メニューアイコン()をクリックし、File > プロジェクトの保存/Save Projectを開きます。

セーブ・ウィンドウでは、プロジェクトを保存する場所を選択することができます。 

 

ひとつの曲として保存や書き出しを行う場合、ソングモード/Song Modeでシーケンスを並べて曲に組み上げます。 

ソングモードに入るには、再生が停止していることを確認して、ツールバーのモードアイコンの横にある下向き矢印()か

らソング/Songをクリックします。 

ソングモードでは、作成した各シーケンスがパッドにアサインされています。パッドの左隣にあるシーケンス/Sequenceリス

トパネルは曲の構造(シーケンスの再生順や再生回数など)を表示します。ウィンドウの上半分は、曲の構造の各シーケンス

を表す「ブロック」が横並びで表示されます。ソングを組んでいないデフォルトの状態ではそれぞれ空になっています。 

実際にソングを組むにはパッドからシーケンスリストパネルへ、または上部メインウインドウに(パッドの)シーケンスをドラッ

グ&ドロップしてシーケンスリストに順番に並べていきます。(シーケンスとシーケンスの間にもインサートできます。)並べた

シーケンスを消す場合は、消したいシーケンスをリストで選択してからパッド右側の DELETE STEPを押して削除します。 

ツールバーの再生ボタンで曲を再生すると、シーケンスリストに並べたシーケンスを順番に再生していきます。Rpts はシー

ケンスの再生回数、BPM はシーケンスのテンポ、BARS はシーケンスの小節数を表しています。シーケンス毎にそれぞれ独

立した設定ができます。 

 

重要：各シーケンスにはそれぞれ独自のテンポがありますが、再生がマスターテンポに従うように設定されている場合、各シ

ーケンスの個別のテンポは無視されます。デフォルトでは、各プロジェクトはシーケンスのテンポを使用するように設定され

ています。すべてのシーケンスで同じテンポを使用するようするには、ウィンドウの上部にある Seq/Mst ボタンをクリックし

て（Mstに切り替えて）、マスターテンポを入力・設定することをお勧めします。 

 

ソングが組みあがったら、曲全体をエクスポートしてオーディオファイルにしてみましょう。 

曲をエクスポートするには： 

1. 画面左上のメニューアイコン()をクリックして、File > Exportを選択し、

As Audio Mixdownをクリックします。 

2. 表示された Audio Mixdown画面で、以下の操作を行います。： 

• Start bar のフィールドが 1 に設定されていることを確認し、

End barのフィールドを曲の最後の小節に設定します。 

• Audio tail フィールドを 2 秒に設定します。この設定はリバー

ブやディレイなどの残響が曲の最後に残る場合に有効です。 

• エクスポートするファイル形式を File formatから選択します。 

3. Exportをクリックして、曲を保存する場所を選択します。 

保存時に曲名を付けるには、File フィールドで名前を入力し、Save を

クリック、または PCの Enterキーを押してエクスポートします。 
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ネクスト・ステップ 
 

このクイックスタートガイドでご紹介したモードやツールに加えて、MPC Beats ソフトウェアには、さらにクリエイティビティ

を高めるための多くの機能が備わっています。例えば、以下のような機能があります。： 

• Samplerと Looper：サンプリングやループレコーディングができます。※要オーディオインターフェース 

• Sample Edit Mode：録音サンプルの編集、サンプル分割(チョップ)、パッドへのアサインができます。 

• Step Sequencerと LISTエディター：より細やかなシーケンスのプログラム・編集ができます。 

• Clipモード：ドラムループなど複数ファイルを BPM同期させて同時ループ再生することができます。 

• 画面左上メニューアイコン>Edit：シーケンス、トラック、プログラムの高度な編集機能を使用できます。 

MPC Beatsを DAWでプラグインとして立ち上げたい場合、各 DAWソフトでプラグインフォルダをスキャン、または設定

して下さい。環境により異なる場合がございますが、基本的には下記フォルダに収納されています。 

 

Windows (64-bit): 
C:Program Files/Steinberg/vstplugins 
 
Mac: 
Macintosh HD/Library/Audio/Plug-Ins 

その他のサポートについては、以下のサイトをご覧ください。 http://akai-pro.jp/support/ 

 

プラグインのセットアップ 
プリファレンスからプラグインフォルダを指定・追加することで、VST/AU規格の様々なプラグインが使用できるようになり、

さらに幅広い楽曲制作が可能になります。※プラグインフォルダの場所はメーカーにより異なる場合があります。 

例) ●Windows (64-bit): C:\Program Files\VSTplugins  ●MacOS: Macintosh HD\Library\Audio\Plugins\VST 

 

起動に関してはトラックとプログラムの追加>新しいプラグインプログラムを作成するにはの項目をご参照ください。 

その他のサポートについては、以下のサイトをご覧ください。 http://akai-pro.jp/support/ 

http://akai-pro.jp/support/
http://akai-pro.jp/support/
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コードプログレッションの機能がうまく動作しない・単音しかならない場合 
 

環境設定内の MIDI/Sync設定をご確認いただけますでしょうか。 

 

パッドをマッピングしなおしてお試しいただけますでしょうか。 
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商標とライセンス 
Akai Professional は、米国およびその他の国で登録された inMusic Brands、Inc.の商標です。 Akai Professional および 

MPC は、InMusic Brands、Inc.の米国およびその他の国における登録商標です。 Kensington と K＆Lock のロゴは ACCO 

Brands の登録商標です。macOS は Apple Inc.の米国およびその他の 国における登録商標です。Windows は、Microsoft 

Corporation の米国およびその他の国における登録商標で す。 他のすべての製品名、会社名、商標、または商号は、それぞ

れの所有者のものです。akaipro.com/product-legal. 

 


